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Chris Lyner - TILTPIXEL 
 
Ramy Hanna – TILTPIXEL 

 

 

Description 
Generating your standard fly-through animation doesn't cut it anymore in the architecture industry. 
Creating an interesting piece that will excite your client and captivate the audience requires some 
forethought. In this class we will go through an animation process, highlighting techniques used on a 
recent project that Tiltpixel was tasked with to sell an idea for a private school in South America. Using 
3ds Max software we will go through setting up complex scenes, touching on lighting, rendering, and the 
post-production process. 

 

Learning Objectives 
• Learn how to set camera paths in 3ds Max 

• Learn efficient and effective ways to create quick animatics 

• Discover how render elements work 

• Utilize render elements and other tricks in post-production 

 

About the Speakers 
Chris Lyner - is a 3D artist at TILTPIXEL.   

He began his career selling and training in Autodesk and Adobe software.   For the past 8 years Chris has 
been doing animation, 3d imagery, and corporate videos for architecture, transportation, water 
treatment facilities, mining, ports, and oil & gas.  His work has been featured in multiple Revit Essentials 
books, Architecture MN magazines, and recognized in a documentary put together for Dredging Today.  
Chris is an instructor at the Art Institute of Houston.  He ran the local MN 3ds Max User Group and 
assisted with the Minnesota Electronic Theatre.  He was also on the Minnesota SIGGRAPH committee.   

Ramy Hanna - is a partner and 3D artist at TILTPIXEL.  

He has been in the arch-viz industry for the last decade creating architectural renderings and animations. 
He is familiar with various 3D software and a variety of rendering engines. He also dabbles in 
architectural photography and has had the privilege to win several design awards including AIA Design 
Awards. He has also spoken at several speaking engagements such as Autodesk University, RTC, and 
VisDay. Ramy is an online instructor for The Gnomon Workshop and Blackspectacles.com. Since 2009, he 
has been on the 3dsmax beta team providing input into the design of 3ds Max software. In 2003, he was 
involved in an animated short nominated at SIGGRAPH, and in 2006 his animated short played in AMC 
movie theatres nationwide. 
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Before we get started here is a comparison between the sketchup model provided and a 
finished frame from our animation. 

 

BEFORE 

 
AFTER 
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Building your Scene 

 
 Before any work begins, here are a few things to take into consideration… 

 

• Deliverables from the client 

The scope of the project greatly depends on the client deliverable.  This ranges from 3d 
models out of 3d CAD, Revit, Sketchup, Rhino, etc to 2d CAD, or sometimes just a napkin 
sketch.  In this case we were provided a Sketchup model. 

• Model Cleanup 

                           

There are a number of steps 
that need to be taken into 
consideration before 
importing a model into 3ds 
Max.  Knowing the units of 
scale in which the model was 
created being the first.  Set 
your max scene to the correct 
units.  

Customize>Units 
Setup>System Unit Setup and 
change the units the same as 
file being imported.   

 

 
 

                      

In this case, the model came from Sketchup which is notorious for having flipped faces.  
This requires some tedious and time consuming cleanup.  In the modifier stack, add an 
edit poly over the edit mesh, in sub object mode and at the polygon level begin to flip 
faces if inverted. 
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• Entourage, Trees, Cars, etc 
In scenes that require a lot of high poly objects we use a mixture of techniques, from xref 
objects, to vray proxy objects, and the iTooSoft forest pack plugin.  This gives us the detailed 
quality we are looking for while keeping our files light enough to render in one scene. 
 

 
 

• Large Scenes 

For scenes with multiple buildings, we will typically clean up the buildings individually and save 
them out seperately.  They are then brought in as xrefs to  the master model.  This will keep the 
file size down and be a huge timesaver at render time.  To xref a scene go to 
File>References>XRef Scene.  Click the Add tab.  Note that you can ignore Lights, Cameras, 
Shapes, Helpers, Animation.  This is helpful where you would otherwise have muliple of the 
same daylights or cameras for instance. 
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Setting a camera path in 3ds Max

Setting up camera options 
Prior to creating any shots, we send our client a storyboard that “loosely” outlines the overall 
flow of the animation. When we choose camera paths for our animation, we will typically create 
a few options highlighting interesting features within each space.  We render out a single frame 
from each camera and send it to the client for approval.  Once our client had chosen the views 
they like best for each shot, we then generate an animatic. 

Storyboard 
The storyboard is the most effective way for the client to see a breakdown of how the animation 
will come together before the production begins.  It’s an essential part of the process as it allows 
them to offer feedback on the production before any real work is done. This outlines everything 
from the camera shots and movements, transitions, sound effects, and audio track. 

This is an example of our clients’ feedback on shots for an animation. 

 
 

Setting Camera paths 
For each shot, we typically generate at least 3 views for each shot.  These views are sent as stills 
to the client for them to choose the most suitable shot.  Keeping the client engaged throughout 
the entire production process is important to keep in mind! It allows them to feel they are 
playing a significant role in the creation of the piece and will help build your relationship with 
that client. 
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Creating the Animatic 
 

Creating the preview in 3ds Max 
  

Once the client has 
chosen the views they 
like, we animate cameras 
from the selected views.  
Within 3ds Max we 
create a preview 
animation for each shot.  

Tools>Preview Grab 
Viewport>Create 
Preview Animation 

 

 

 

Generating an Animatic 
After we’ve created previews for each shot, we tie them together in our editing software.  The 
animatic does not need to be complex and is intended to give the client a more clear visual for 
what the end product will be, so we don’t go overboard with effects or transitions.  However, 
we do put the audio and sound effects in to give them the full effect.
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Production

Texturing and Materials 
The devil is in the details and this certainly applies to materials as well!  We use a number of 
techniques in our material development to achieve a realistic look to our surfaces.  For the 
purposes of this class we will only be touching on material conversions for Vray.  This is 
important because materials coming from Revit, Autocad, and Sketchup are standard materials 
and will cause lighting and flickering issues at render time.  The best way is to manually go 
through your materials and convert them, but if you are pressed for time, you can run the Vray 
scene converter by simply right clicking in your scene and going down to Vray Scene Converter.  
This will automatically convert all materials in your scene for you. 

 

 
 

 

 

Animating 
Limit cameras to 5 seconds or so each.  This allows focus on the nice details of the spaces and 
keeps the viewer engaged.  When a single “flythrough” camera is set through a space there is no 
emphasis placed on details or design and the viewer becomes easily disengaged. 

Pans, dolly’s, etc. like a real camera.  These movements create interest and diversity in your 
animation.  It also gives a sense of realism to the animation. 

No cameras on splines!  This creates an unnatural camera movement that is known as the 
“flythrough” animation.  This makes for an uneventful and dull animation. 

Trees, cars, and other animated objects.  Having subtle secondary animation in your scene, if 
done right, will bring in a new level of interest and realism to your video.  Be careful not to 
overdo it as it can become a distraction and ultimately ruin the shot. 
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Rendering 
Lighting solutions (light cache / ir map / brute force).  When generating an animation, 
understanding the render settings is crucial to the quality of the final image sequences.  When 
sending a sequence to a render farm using Backburner, Deadline, etc., it is important to 
understand and set up your Global Illumination or GI settings correctly.  If done incorrectly, each 
machine rendering a sequence will generate different lighting results in the frame and flickering 
will occur in the animation. 

IR/LC GI 

For a sequence with camera movement only, we typically set our GI to Primary to Irradiance 
Map (IR) and our Secondary to Light Cache (LC).  Render this locally!  Once both IR and LC has 
finished and the render has started, cancel and save both maps.   

 

Make sure to check the use camera 
path box.  
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Change the mode for both from Single 
Frame to From File.  Then point to 
where you’ve saved the file. 

Brute Force GI 

For a sequence with secondary animation i.e. moving cars, trees, people, leaves, etc., we use 
Brute Force for GI.  It is slower, but results in no flickering.  This does not require any saved GI 
maps so just send your sequence to the farm! 

Rendering .png with Alpha 

I typically render my sequences as .png with alpha checked.  Unless it is an interior shot (alpha is 
not needed for interiors.)  There are two reasons for this, .png is a light file that retains lots of 
pixel information and when you have alpha checked, your post software allows you to turn on 
your sky giving you more control in post.  This will be covered later in the coarse. 

Postproduction 
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Discover how Render Elements work

Beauty Pass 
This is the base render in which all other passes will be applied. 

Ambient Occlusion Pass 
The AO pass defines edges and helps create depth.  We change the blend mode to Multiply and 
set it to 30% or 40% in Opacity. 
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Reflection Pass 
Reflection is used to enhance the gloss and reflections in the render.  This pass should be set to 
Screen in the blend mode and set to around 30% Opacity in most cases. 

Refraction Pass 
Refraction will enhance detail beyond transparent objects and help interior spaces “pop”.  Set 
this to Screen in the blend mode and usually no more than 30% Opacity. 
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Zdepth Pass 
Zdepth is an important pass primarily in exterior shots.  It controls fog, atmosphere, and many 
other effects.  Here we us it to control the lighting on the trees, depth of field, fog, and 
atmosphere. 

Multi Matte Passes 
Multi-matte passes are the most effective way to isolate and take control over certain objects in 
post-production.   
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Working with Transparency and Render Elements 

If you want to use render elements for objects 
that have transparent properties such as glass, 
notice that the elements below on the left side 
don’t really work the way we need them to.  
They are treating the glass like an opaque 
object.  Fortunately, there are a few extra steps 
that can be taken to get the elements below on 
the right side. 

Wrong Elements Correct Elements 

Alpha Alpha 

Occlusion Occlusion 
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Z Depth Z Depth 

Wrong Elements Correct Elements 

Reflection Reflection 

Refraction Refraction 

Multi-Matte Multi-Matte 
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To get correct elements for transparent objects in 
v-ray, it really is all starts with the objects
material settings under Refraction.  By default it’s
set to Color only.  Be sure to set it to All
channels.  That’s all there is to it (with exception
for the occlusion pass).  This will ensure accurate
elements based on the objects refraction.  Note
that you cannot have both reflection and
refraction set to All channels for this to work.
Render Elements will use one or the other but
can’t do both!  So if you are needing reflection
through refraction, think about rendering several
elements for each refraction and reflection.

For Occlusion to work, the tweaks must be made 
in the Dirt map itself.  Be sure to check “work 
with transparency”.  Then click on the “Exclude” 
button.  In this dialogue select the refractive 
objects from the left and add them to the right 
side for the dirt map to exclude these from being 
occluded. 
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Using Render Elements and other tricks in post-production 

   BEFORE   AFTER 

Pre-comp using the render elements 

We set the elements in a preliminary composition.  This comp is where the initial compositing of 
all our passes takes place.  When importing the diffuse pass for exterior scenes, it is important 
to import it twice!  One will use the alpha, the other we will not.  This will give us control over 
the sky.  In this tutorial we will be using Adobe After Effects. 

For the diffuse pass WITH the sky, you will 
need to change the alpha properties from 
Straight-Unmatted to ignore by going into 
the interpret footage dialogue, (Ctr+Alt+G, 
or File>Interpret Footage.)  This only needs 
to be done for the diffuse where we want 
the sky to come through. 
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Once the comp has been set up and all our passes are imported, I bring my diffuse with sky pass 
in first.  Then I lay the diffuse without sky next.  I color correct the sky and the building and 
foreground will not be affected.   

The next pass I bring into the comp is the Ambient Occlusion (AO pass).  Change the Blend 
Mode to Multiply and set the opacity to around 30 or 40 percent. 
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Then we bring in the Reflection pass.  Change the Blend Mode to Screen and set the opacity to 
around around 10 or 20 percent. 

Next is the Refraction pass.  Change the Blend Mode to Screen and set the opacity to a desired 
amount, in this case 20%.  Extreme close-ups are usually around 5%. 
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Next is the Z-Depth pass.  This pass can be used for multiple effects in post.  For this 
demonstration we will simply be using it for environment or fog.  There is a bit of a process to 
this layer.  

The first step is to do the same interpret footage 
trick we did to the diffuse for the sky.  Again 
change the alpha properties from Straight-
Unmatted to Ignore by going into the interpret 
footage dialogue, (Ctr+Alt+G, or File>Interpret 
Footage.)   

Now convert the Z-Depth layer to a precomp.  
With the layer selected hit Ctrl+Shift+C.  Then 
change the Blending Mode to Screen.   



AV9820 

Animation Breakdown 

20 

Now go into the Z-Depth precomp and apply an 
Invert, Levels, and Gaussian Blur effect to the 
layer.  Adjust the Levels until you get a desired 
result for the fog falloff.  Set the Gaussian Blur 
to somewhere between 4-9.  Just enough to blur 
any sharp edges. 

Lastly, go back to your base pre-comp and 
adjust the Opacity of the Z-Depth pre-comp.  
This value should not exceed 20%, the effect is 
only meant to be subtle. 

Next is the Multi-Matte pass.  This pass can be used to control the objects that have been assigned 
material ID’s in 3ds Max.  For this demonstration we will simply be using it for controlling lighting, color 
correction, and blooms on the trees.  
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The first step is to create a final comp from your 
pre-comp for the shot.  This must be done for 
the Multi-Matte pass to work as a mask! 

Now bring the Multi-Matte pass into the final 
comp above the pre-comp layer.  Turn the 
Multi-Matte pass to non-visible (we are only 
using it as a mask.)  Create an Adjustment Layer 
above the precomp layer, but under the Multi-
Matte layer (this is where we will be able to add 
effects to the matte selection.  Now set the 
Adjustment Layer Track Matte to Alpha Matte 
“name of layer above”.   

With the hidden Multi Matte layer selected, 
unhide it so you can see the effect that will take 
place and add a Set Matte effect.  Change the 
Use for Matte dropdown from Alpha Channel to 
either Red, Green, or Blue Channel depending 
on what objects you are wanting to adjust.  In 
this case I’ve chosen the Red Channel which will 
affect my vegetation. 

Now make the Multi Matte layer hidden again.  
Select the Adjustment Layer and apply whatever 
effects you want.  In this case I will add Levels 
and Equalize effects to adjust my vegetation.  
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BEFORE  Multi Matte  AFTER Multi Matte 

Final-comp using the Render Elements 
Then in our Final Comp we do our final color grading, vignetting, glows, and any other effects 
we deem necessary to enhance the final quality of the shot.  This process is repeated for every 
shot used in our animation.  
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Final Post Production 
Once all of our scenes have been compiled, color graded, and exported, we create an Adobe 
Premiere sequence where we compile the final animation.  This is the final edit where all the 
transitions for shots, timing of audio, titling, and folly effects are added.   

To keep up with the latest happenings and tutorials from Tiltpixel: 

Blog: tiltpixel.com 

twitter: @tiltpixel 

Facebook: tiltpixel 

http://tiltpixel.com/?page_id=145
https://twitter.com/tiltpixel
https://www.facebook.com/Tiltpixel/
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